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INTRODUCTION TO HOPEX IT PORTFOLIO 
MANAGEMENT

HOPEX IT Portfolio Management is a tool edited by  MEGA International to assist IT
management in:

 Alignment of the application assets with business requirements.
 Reduction of IS operating costs by removing applications no longer used.
 Manage technologies relating to applications;
 Identification of business services covered by applications or application versions.
 Decisions on investments for maximum profits.

HOPEX IT Portfolio Management has been designed to enable:

 Definition of an application assets management workflow, identification of the 
different profiles involved and association of persons with each of these profiles.

 Inventory of applications, specification of their characteristics, the technologies 
used and definition of costs.

 Evaluation of all applications on relevant criteria.
 Generation of comparison and analysis reports leading to effective transformation 

of application assets.

The purpose of this guide is therefore to present how to make best use of these functionalities for
the successful evolution of your information system.

 "Governance with HOPEX IT Portfolio Management", page 10
 "Profiles of HOPEX IT Portfolio Management", page 12
 "About This Guide", page 16
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GOVERNANCE WITH HOPEX IT PORTFOLIO MANAGEMENT 

Associated with other HOPEX Suite products,   HOPEX IT Portfolio Management
enables description of all components involved in management of the enterprise
application assets.

Application and technology inventory

HOPEX IT Portfolio Management allows you to collect information relating to
your application and technology assets. 

To manage a consistent repository of your application assets, HOPEX IT Portfolio
Management relies on the following data:

• Life Cycles describing the different states that Technology, Application 
or Deployment object types can take over a given period.

• Business Processes: a standard business process tree nomenclature is 
supplied with HOPEX IT Portfolio Management.

• Business lines corresponding to major product segments, distribution 
channels or business activities, according to enterprises.

• Org-Units of the enterprise.
• Sites hosting applications.
• Business Capabilities of the enterprise.
• Software or hardware Technologies required for operation of 

applications.
• Editors, suppliers of technologies.
• Costs described based on nomenclature simplifying analysis.
• Functionalities offered by the applications.
• Business Data exchanged between applications.

Tools are proposed to check global consistency of information collected.

Application and technology evaluation
HOPEX IT Portfolio Management enables comparison of applications inventoried
on criteria such as cost, use rate or criticality for the enterprise, and proposes
different reports for this purpose.

Transforming application and technology  assets

HOPEX IT Portfolio Management allows you to plan and follow up transformation
of your application and technology assets. You can create transformation scenarios
for your application and technology portfolios.

In an application portfolio, an application is described by an initiative which
represents possible evolution of the application, allowing us to envisage costs and
life cycle linked with this evolution. 

Several scenarios can relate to the same application, representing different
evolution hypotheses (exclusive between themselves) of the same application.
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Scenarios can be created, by selection of a set of initiatives to be achieved, and
these scenarios can then be compared.
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CONNECTING TO HOPEX IT PORTFOLIO MANAGEMENT

The menus and commands available in HOPEX IT Portfolio Management depend
on the profile with which you are connected.

Connecting to the solution

To connect to HOPEX IT Portfolio Management, see HOPEX Common Features,
"HOPEX Desktop", "Accessing HOPEX (Web Front-End)".

Profiles of HOPEX IT Portfolio Management

In HOPEX IT Portfolio Management, there are default user profiles with which
specific rights and accesses are associated. The profiles available are:

• ITPM Functional Administrator 
• Application Portfolio Manager 
• Application Owner
• Chief Technology Officer
• Technology Portfolio Manager
• Financial Controller 
• Business owner 
• IT Owner 

The rights of different users on objects of imported libraries depend on their
assigned profiles. For more information on creation of users and assignment of
profiles, see the chapter "Managing Users" in the HOPEX Administration -
Supervisor guide.

Functional Administrator

The functional administrator has rights on all objects and workflows.

He/she prepares the work environment and manages reference data used in the
solution.

Application Portfolio Manager

The Application Portfolio Manager:
• is responsible for the global process and its control. 
• assures correct operation of tasks assigned to the "Application 

Owner".
• classifies and evaluates applications.
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To allow the "Application Portfolio Manager" to control the inventory of the
application assets, application data entry and validation workflows are delivered
with HOPEX IT Portfolio Management.

For more details on workflows, see the HOPEX Common Features guide. 

Application Owner

The role of the Application Owner is to specify characteristics of applications for
which he/she is responsible, and to regularly update these.

Chief Technology Officer

The Chief Technology Officer is an Application Portfolio Manager who is also in
charge of technologies evaluation. The assessment is driven by a workflow. See
"Validating a Technology", page 44.

Technology Portfolio Manager 

The Technology Portfolio Manager is in charge of one or several technology
portfolios. He choses technologies and editors, and asks for the Technology Director
validation.

Financial Controller

The role of the Financial Controller is to specify financial characteristics of
applications and technologies for which he/she is responsible. 

Business User

Business user of the application. Evaluates business aspects of applications for
which he/she is responsible.

IT Owner

Responsible for application IT. Evaluates technical and technological aspects of
applications.

For more details on assessment, see "Evaluating Application Criticality", page 56.
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INTERFACE PRESENTATION

The menus and commands available in HOPEX IT Portfolio Management depend
on the profile with which you are connected.

 For more details on the use of analysis reports, see the HOPEX 
Common Features.

Workspace and profiles

The navigation panes correspond to the various types of objects or various steps of
a project. Depending on your connection profile, the object types displayed vary.

Presentation of space common to all roles

All HOPEX IT Portfolio Management users have access to the following panes: 
• Home: provides quick access to user objects.
• Dashboards: displays the list of indicators required to steer objects 

such as processes, applications or org-units.
• List of tasks: displays the tasks assigned to the user.

Functional administrator space

In addition to the panes offered in standard mode to all desktop users, the
Functional Administrator has access to the following navigation panes:

• Administration: used to manage users and profiles.
• Environment: used to organize all repository elements, It allows the 

Functional Administrator to define the work environment. See "Preparing 
the Work Environment", page 20.

• Inventory: management pane for application assets. Folders enable 
viewing of applications created outside an inventory portfolio, 
applications without owner, deployed applications, etc.

• Evaluation: pane dedicated to evaluating portfolios and associated 
applications. 

• Campaign Management: used to manage evaluation campaigns.
• Transformation: pane dedicated to transformation portfolios.
• Reports: presents a set of dynamic reports that enable repository data 

analysis according to different perspectives.

Application Portfolio Manager space

In addition to the panes available in standard mode to all desktop users, the
application portfolio manager has access to the three Inventory, Evaluation and
Transformation navigation panes. These are specific to each step of an application
portfolio management project. The application portfolio manager also has access to
the Reports pane.
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Application owner space 

The Application Owner, like the management controller or the business function
manager, has access to the following shared navigation panes only: Home,
Dashboards and List of tasks.

Technology Portfolio Manager space

The Technology Portfolio Manager has the same tabs as the Application Portfolio
Manager. The difference is in the accessed objects: technologies and technology
portfolios.

Technology Director space

The Technology Manager has the same tabs as the Technology  Portfolio Manager.
Additionally, he has the validation technology task.
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ABOUT THIS GUIDE

This guide presents how to make best use of HOPEX IT Portfolio Management
to assure governance of your enterprise application assets.

Guide Structure

The HOPEX IT Portfolio Management guide comprises the following chapters:
• "Functional Administration", page 21: describes initializations of 

reference data to be set up before starting an application assets 
inventory campaign.

• "Inventory of Applications", page 27: presents functionalities proposed 
by HOPEX IT Portfolio Management to identify and characterize 
application assets.

• "Evaluating Application Assets", page 65: introduces the portfolio 
concept available in HOPEX IT Portfolio Management and explains 
how to evaluate applications during the inventory phase.

• "Transforming an application portfolio", page 79: presents the scenario 
concept on which the transformation phase relies.

• "Glossary", page 99: summarizes definitions of the main concepts used 
in HOPEX IT Portfolio Management.

• "Importing Technology information from BDNA Technopedia™", page 93: 
describes use of BDNA connector.

Additional Resources

This guide is supplemented by:
• The HOPEX Common Featuresguide describes the Web interface and 

tools specific to HOPEXsolutions.
 It can be useful to consult this guide for a general presentation of 
the interface.

• the HOPEX Administration - Supervisor administration guide.
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Conventions Used in the Guide

Styles and formatting

 Remark on the preceding points.

 Definition of terms used.

 A tip that may simplify things.

 Compatibility with previous versions.

 Things you must not do.

Commands are presented as seen here: File > Open.

Names of products and technical modules are presented in bold as seen here:
HOPEX.

Formulating command sequences 

To reference a command in the solution, and with a view to simplification, the
following formulation has been adopted in this guide: 

Example of a command with its formulation in the guide

Very important remark to avoid errors during an operation.

Application command Formulation adopted in this 
guide

In the Environmentdesktop, click Risk 
Universe > Controls > Control 
Types.
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FUNCTIONAL ADMINISTRATION

So that the different participants can play their business role, the functional administrator must first
prepare the work environment. 

This consists of:

 "Accessing the Work Environment", page 20
 "Defining Enterprise Org-Units", page 20
 "Describing Enterprise Sites", page 21
 "Defining Business Lines", page 22
 "Defining Business Processes", page 22
 "Defining Business Capabilities", page 23
 "Defining Life Cycles", page 24
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PREPARING THE WORK ENVIRONMENT

Inventory and evaluation of the application assets are based on description of
business elements - in order to map business requirements with the application
architectures that serve as their support - as well as organizational elements such
as org-units and deployment sites. 

The following points indicate how to create elements that constitute your work
environment. This step is executed by the Functional Administrator.

Accessing the Work Environment

Environment components are accessed by the administrator in a dedicated space.

To access the environment:
1. Connect to HOPEX IT Portfolio Management as administrator.
2. Click the navigation menu, then Environment.

The Libraries folder displays all repository libraries and associated
objects. 

 Libraries enable classification of repository objects and therefore 
breakdown of repository content into several parts.

Defining Enterprise Org-Units

HOPEX IT Portfolio Management is used to describe the org-units of your
enterprise.

 An org-unit represents a person or a group of persons that 
intervenes in the enterprise business processes or information system. 
An org-unit can be internal or external to the enterprise. An internal 
org-unit is an organizational element of enterprise structure such as a 
management, department, or job function. It is defined at a level 
depending on the degree of detail to be provided on the organization 
(see org-unit type). Example: financial management, sales 
management, marketing department, account manager. An external 
org-unit is an external entity that exchanges flows with the enterprise. 
Example: customer, supplier, government office.

Creating org-units

To create an org-unit:
1. Connect to HOPEX IT Portfolio Managementas administrator.
2. Click the navigation menu, then Environment.
3. Click Libraries.

The list of libraries and associated objects appears in the edit area.
4. Right-click the library that will hold the org-unit and select New > 

Modeling Block.
A selection dialog box appears.
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5. Select the "Org-Unit" MetaClass and click OK.
The org-unit creation wizard opens.

6. Indicate the name of the org-unit and click OK.
The org-unit appears in the edit area, in the specified library. 

Specifying org-unit properties

To specify the properties of an org-unit:
1. Connect to HOPEX IT Portfolio Managementas administrator.
2. Click the navigation menu, then Environment.
3. Click Libraries.

The list of libraries and associated objects appears in the edit area.
4. Right-click the org-unit concerned and select Properties.
5. In the Characteristics page, in the Org-Unit type field, select the org-

unit. 
There are several types of org-units:
• An "Accountable" org-unit (for example, Sales Manager).
• A "Generic" org-unit corresponds to a role to be played during a 

project (for example, Writer, Requester).
• A "Structure" org-unit (for example, Sales Management).
• A "Function" org-unit (for example, Sales Engineer).

 You can also specify its details (company name, e-mail address, 
telephone number, etc.).

Describing Enterprise Sites

HOPEX IT Portfolio Management allows you to describe sites of your enterprise.
These sites are used to define the deployment context of an application.

 A site is a geographical location of an enterprise. Examples: Boston 
subsidiary, Seattle plant, and more generally the headquarters, 
subsidiaries, plants, warehouses, etc.

To create a site:
1. Connect to HOPEX IT Portfolio Managementas administrator.
2. Click the navigation menu, then Environment.
3. Click Libraries.

The list of libraries and associated objects appears in the edit area.
4. Right-click the library that will hold the site and select New > Modeling 

block.
A selection dialog box appears.

5. Select the "Site" MetaClass and click OK.
The site creation wizard opens.

6. Indicate the name of the site and click OK.
The site appears in the edit area, in the specified library. 
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Defining Business Lines

 A business line is a high level classification of main enterprise 
activities. It corresponds for example to major product segments or to 
distribution channels. It enables classification of enterprise processes, 
organizational units or applications that serve a specific product and/or 
specific market. Regulation frameworks of certain industries impose 
their own business lines.

To create a business line:
1. Connect to HOPEX IT Portfolio Managementas administrator.
2. Click the navigation menu, then Environment.
3. Click Libraries.

The list of libraries and associated objects appears in the edit area.
4. Right-click the library that holds the business line and select New > 

Modeling block.
A selection dialog box appears.

5. Select the "Business Line" MetaClass and click OK.
The business line creation wizard appears.

6. Specify the name of the business line and click OK.
The business line appears in the edit area, in the specified library. 

Defining Business Processes

APQC proposes standard repositories of business processes specific to each major
activity sector.

 A business process represents a system that offers products or 
services to an internal or external client of the company or organization. 
At the higher levels, a business process represents a structure and a 
categorization of the business. It can be broken down into other 
processes. The link with organizational processes will describe the real 
implementation of the business process in the organization. A business 
process can also be detailed by a functional view.

A set of standard business process repositories from APQC is supplied with  HOPEX
IT Portfolio Management.

 For more details on importing APQC business processes, see 
"Importing Specific Libraries", page 18.

To access business processes of your enterprise:
1. Connect to HOPEX IT Portfolio Managementas administrator.
2. Click the navigation menu, then Environment.
3. Click Libraries.

The list of libraries and associated objects appears in the edit area. The
Process folders attached to the libraries contain the repository business
processes.
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Defining Business Capabilities

A business capability map is business capability mapping, each business capability
grouping applications according to functional similarity.

Several grouping strategies can be defined. It is therefore possible to define several
business capabilities describing the information system from different points of
view.

 A business capability is a component of information system 
processing. Processing can for example correspond to an activity or an 
enterprise business.

You can create a business capability map for a user or portfolio.

The business capability map of a user reflects the functional coverage of applications
used for a given org-unit.

The business capability map of a portfolio reflects functional coverage of
applications of a given portfolio. It is particularly useful to view the functional
coverage change of application assets over time. See "Generating the Portfolio
Business Capability Map", page 63.

Capabilities can be previously defined in a global capability map. The existence of a
business capability map of the company enables automatic creation of business
capability maps subsequently generated at the user or portfolio level. You can also
create capabilities directly from applications.

To associate a capability with an application, see "Defining Application Functional
Scope", page 31.

Creating a corporate business capability map

The global capability map can be created by the administrator in the Environment
desktop.
To create a corporate business capability map:

1. Connect to HOPEX IT Portfolio Managementas administrator.
2. Click the navigation menu, then Environment.
3. Click Libraries.

The list of libraries appears in the edit area.
4. Click the icon of the library to which to attach the capability map and 

select New > Business Capability Map. 
The business capability map creation dialog box opens.

5. Enter its name.
6. Click OK.

Creating the business capability map of a portfolio

To create the business capability map of a portfolio:
1. Click the navigation menu, then Inventory.
2. In the navigation pane, click All application portfolios.

The list of repository application portfolios appears in the edit area.
3. Click the icon of the portfolio concerned.
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4. Select New > Business Capability Map / Portfolio.

See also "Generating the Portfolio Business Capability Map", page 63.

Creating a business capability

You can create business capabilities in a business capability diagram or from
applications.

To associate a capability with an application, see "Defining Application Functional
Scope", page 31.

Business capability properties

To view characteristics of a business capability:
 Open the properties pages of the business capability.

The City planning level is indicated in the corresponding box (area, district or
block).

The Color attribute brings a further dimension to your business capability diagrams.
The value given to this attribute changes the shape color representing the area,
district or block displayed in the diagram.

The City Planning tab is used to specify the applications, databases, services, or
use cases concerned.

Defining Life Cycles

The life cycle of an object defines the list of possible object states. Associated with
begin and end dates, the life cycle of an application is used when planning the
different states of an application during a given period. See "Defining Application
Life", page 38.

Life cycles supplied by default 

HOPEX supplies standard life cycles for applications and deployment contexts. 

Life cycle of an application

This life cycle describes:
• standard development of an application, whatever it might be.
• states that mark steps in evolution of an application. 
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This standard life cycle can apply to all applications.

Creating new life cycles

Modifying a standard life cycle impacts data already modeled in the repository. It is
therefore a modification that should be restricted to appropriate authorization
levels.

To formalize states other than those supplied as standard by HOPEX, it is preferable
to create a new life cycle.

A life cycle corresponds to the "State Machine" object. To define a new life cycle,
you must create a state machine and associate with it the states and transitions
constituting the life cycle.

To create a life cycle with HOPEX IT Portfolio Management:
1. Connect to  HOPEX IT Portfolio Management as administrator.
2. Select the Environment desktop, then Libraries.
3. Click the Libraries folder to display repository libraries and associated 

objects.
4. Click the icon of the library that will contain the state machine, and select 

New > Others. 
5. In the dialog box that appears, select the State Machine MetaClass and 

click OK.
The Creation of State Machine dialog box appears.

6. Enter the Name and click Next.
The new dialog box allows you to specify the list of object types
(MetaClasses) that can be associated with the life cycle created.

7. In the Valid Type section, click Connect.
8. In the dialog box that appears, select the expected object type and click 

OK.
The list of selected object types appears.

9. Click OK.
The new state machine appears under the State Machine folder of the
library.

To create the state diagram associated with the new state machine:
 Click the icon of the state machine and select New > State Diagram.

 For more details on the use of state diagrams, see the  guide 
HOPEX for UML.
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INVENTORY OF APPLICATIONS

The inventory phase consists of collecting information from different viewpoints: descriptive,
functional, financial, technical, etc. This chapter presents functionalities proposed by HOPEX IT
Portfolio Management  to help you inventory the application assets of your enterprise.

The following points are covered here:

 "Building Application Assets", page 28
 "Filling in the properties of an application", page 30
 "Defining Application System Properties", page 36
 "Defining Application Life", page 38
 "Defining and Managing Technologies", page 41
 "Managing Deployments", page 45
 "Managing Application and Application System Costs", page 51
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BUILDING APPLICATION ASSETS 

HOPEX IT Portfolio Management offers the possibility of describing simple
applications or more complex applications via the use of application systems.

Applications and application systems of the organization can be created by the
Administrator, Application Portfolio Manager or Application Owner.

Creating an application

To inventory applications, HOPEX IT Portfolio Management provides a
navigation tree. 

Depending on whether you are an application owner or an application portfolio
manager, you can access applications from the Home page or Inventory
navigation pane of the ITPM desktop.

The navigation pane classifies the applications according to the following criteria:
• All applications of the repository
• Applications without owner
• Applications outside portfolio (those not belonging to any inventory 

portfolio)
• Applications of the connected user portfolio

 This display corresponds to the "List" view. A hierarchical view of 
the Inventory tab is also available.

To create an application:
1. In the Inventory navigation tree, click All Applications.

The list of applications appears in the edit area.
2. Click the New button.
3. In the dialog box that appears, indicate:

• its name 
• its life cycle
• begin and end dates

4. Click Next if you also want to define the different characteristics of the 
application. If not, click OK.

 The user that created an application becomes its manager.

Creating an Application System

An application system comprises applications and/or sub-application systems.

Prerequisite

Application systems are not visible by default To use them in HOPEX IT Portfolio
Management:
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1. On the desktop, click Main Menu > Settings > Options.
The options window appears.

2. In the tree on the left, click the IT Portfolio Management folder.
3. In the right pane of the window, select the option Use of Application 

Systems.
4. Click OK.
5. Save the modification and restart HOPEX IT Portfolio Management.

Creating an application system (as portfolio manager)

The administrator, application owner and application portfolio manager can all
create application systems. 

To create an application system as portfolio manager:
1. Click the navigation menu, then Inventory. 

The navigation pane classifies the application systems according to the
following criteria:

2. Select the All Application Systems folder.
The list of repository application systems appears in the edit area.

3. Click the New button.
4. In the dialog box that appears, indicate:

• its name 
• life cycle
• begin and end dates

 For more details on life cycles, see "Defining Life Cycles", page 24.

• its runtime paradigm: defines how the application system should be 
installed.

5. Click Next if you also want to define the functional scope of the 
application system (see "Defining Application Functional Scope", page 
31). If not, click OK.

Adding an application to the application system

To connect an existing application to the application system:
1. Open the properties of the application system.
2. Click the drop-down list then Characteristics.
3. In the Component section, click Application. 
4. Click New. 

The application component creation dialog box opens.
5. Click the Reuse an application field.
6. From the list of applications, find and select the desired application.
7. Click OK.

Aggregation Type

Applications in the application system can be considered as components or as
independent applications. This distinction modifies evaluation data of application
system costs. See "Application System Costs", page 54.
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FILLING IN THE PROPERTIES OF AN APPLICATION

All elements of an application are accessible from its properties pages.

Accessing Application Properties

Depending on whether you are application owner or application portfolio manager,
you can access applications from the Home or Inventory tab.

To access the properties pages of an application:
1. Click the navigation menu, then Inventory.
2. Display the list of repository applications.
3. In the edit area, select the required application and click Properties.
4. Click the drop-down list to access the following properties pages:

• Characteristics
• Version and Installation
• Evaluation
• Cost
• Wall
• Generates reports

Application Characteristics

To access characteristics that enable identification of an application:
 In the properties window of an application, select the Characteristics 

page.
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You can specify:
• the application identification:

• the Name 
• the internal Code 
• the Type of application
• if it is an Application template: to be selected if the application is 

used to create other applications
• a Comment. 

• the Service Legal Agreement: displays the indicators that define the 
application quality level.

• Functional Scope of the application. See "Defining Application 
Functional Scope", page 31.

• Responsibility: this is the person or persons responsible for the 
application (owner, financial controller, IT owner).

• Technology used. See "Specifying Technologies", page 32.
• Exchanges with other objects. See "Specifying Data Exchanged With 

Other Applications", page 33.
• the Risks associated with the application.
• Gantt Chart of the application presenting the application lifeline. See 

"Defining Application Life", page 38.
• associated Attachments. See "Attachments", page 33.

Defining Application Functional Scope

To indicate the objects that define application functional coverage:
1. Open the application properties.
2. Click the drop-down list then Characteristics.
3. Expand the Functional Scope section. 

 A report covers functional characteristics of a list of applications. 
See "Analyzing an inventory portfolio", page 74.

The types of data that define functional coverage of the application are:
• The business lines that use the application

 A business line is a high level classification of main enterprise 
activities. It corresponds for example to major product segments or to 
distribution channels. It enables classification of enterprise processes, 
organizational units or applications that serve a specific product and/or 
specific market. Regulation frameworks of certain industries impose 
their own business lines.

• The business processes that use the application

 A business process represents a system that offers products or 
services to an internal or external client of the company or organization. 
At the higher levels, a business process represents a structure and a 
categorization of the business. It can be broken down into other 
processes. The link with organizational processes will describe the real 
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implementation of the business process in the organization. A business 
process can also be detailed by a functional view.
 For more details on the list of available business processes, see 
"Defining Business Processes", page 22.

• The business capabilities covered by the application
 For more details on the list of available business capabilities, see 
"Defining Business Capabilities", page 23.
 A report covers distribution of applications in business capabilities, 
see "Generating the Portfolio Business Capability Map", page 63 .

• functionalities implemented by the application

 A functionality is a service required by an org-unit in order to 
perform its work. This functionality is generally necessary within an 
activity in order to execute a specific operation. If it is a software 
functionality, it can be provided by an application.

Connecting a functionality to the application

To create a functionality and connect it to the application: 
1. In the Functional Scope section, select Implemented Functions.
2. Click the New button.

The new functionality appears in the list of functionalities of the
application. 

To connect an existing functionality to the application: 
1. In the Functional Scope section, select Implemented Functions.
2. To do click the Connect button.

The connect wizard appears.
3. Click the Find button.

The list of repository functionalities appears.
4. Select the required functionality.
5. Click Add.

Specifying Technologies

To specify technical characteristics of an application:
1. Open the application properties.
2. Click the drop-down list then Characteristics.
3. Expand the Technology section. 

You can:
• connect existing technologies to the application 
• create new technologies.

 A technology is a definition or format that has been approved by a 
standards organization, or is accepted as a standard by the industry.
 A report covers the list of applications by technology. See 
"Analyzing an inventory portfolio", page 74.

For more details on technologies, see "Defining and Managing Technologies", page
41.
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Attachments

You can attach external references to an application. 

External references are of URL type: They enable association with an object of a
document from a source outside HOPEX. 

To attach an external reference to an application:
1. Open the application properties.
2. Click the drop-down list then Characteristics.
3. Expand the Attachments section. 
4. Click the New button.
5. Indicate the name and URL of the reference.
6. Click OK.

Specifying Data Exchanged With Other Applications

You can describe the message flows exchanged between applications, with their
direction and content. This information enables creation of exchange mapping. 

 A message flow is information flowing within an enterprise or 
exchanged between the enterprise and its business environment. A 
message flow can carry a content.

 A Business data indicates content of a message flow. A Business 
data can be used by several message flows, since it is not associated 
with a sender and a destination. The same business data can be used by 
several message flows.
 For more details on obtaining this report, see "Consulting the 
Application Environment Report", page 34.

Creating a message flow with business data

Business data represents the content of a flow.
 A Business data indicates content of a message flow. A Business 
data can be used by several message flows, since it is not associated 
with a sender and a destination. The same business data can be used by 
several message flows.

To create a message flow  of a source application to a target application:
1. Open the properties pages of the source application.
2. Click the drop-down list then Characteristics.
3. Expand the Exchanges section.
4. Click Sent Message Flow and click the New button.

The Creation of Message Flow - Content dialog box appears.
5. From the Content field, select the business data you want to associate 

with the message flow. 
6. Select the Target Application. 
7. Click OK.

 You can associate several business data to a message flow, see 
"Defining a business data", page 34.
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Defining a business data

To access business data associated with a message flow:
1. Open the properties pages of the application.
2. Click the drop-down list then Characteristics.
3. Expand the Exchanges section.
4. In the Sent Message Flow or Received Message Flow section, select 

the flow in question.
Data associated with the selected flow appears in the Business Data
section.

To associate an existing business data with a message flow:
1. In the  Business Data section, click the Connect button.
2. In the connect wizard, select the search criterion "Proposed Business 

Data" and click the Find button 
The business data list appears.

3. Select the name of the business data and click OK.

Specifying the risks associated with an application

HOPEX IT Portfolio Management is used to identify the risks associated with an
application, and to retrieve the evaluations defined in the HOPEX Enterprise Risk
Management solution. You can define a new risk using the application or connect
a previously defined risk.

To connect a risk to an application:
1. Open the properties pages of the application.
2. Click the drop-down list then Characteristics.
3. Expand the Risk section.
4. Click Add.

The query dialog box appears.
5. Find and select the risk required and click OK.

For more details on risks and their evaluation, see HOPEX Enterprise Risk
Management.

Consulting the Application Environment Report

This report presents, below a diagram shape, links between an application and its
environment. Components appearing in the diagram can be applications,
deployments, technologies, functionalities, consumer org-units or business
processes.
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To create an application environment report:
1. Click the icon of an application and select New > Application 

Environment Report.
The report appears in the edit area.

 The links between applications correspond to message flows 
exchanged.
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DEFINING APPLICATION SYSTEM PROPERTIES

Similarly to applications, the inventory phase consists of collecting information on
application systems from different viewpoints: descriptive, functional, financial,
technical.

Accessing Application System Properties

Depending on whether you are application owner or application portfolio manager,
you can access application systems from the Home or Inventory tab.

To access application system properties:
 In the list of repository application systems, select the required 

application system and click the Properties button of the edit window.
Application system properties pages appear:
• Characteristics
• Installation
• Evaluation
• Cost
• Wall
• Generates reports

Application System Characteristics

To access characteristics that enable identification of an application system:
 In the application system properties, select the Characteristics page. 

You can specify:
• the Identification (name, internal code, etc.)
• the Service Legal Agreement: displays the indicators that define the 

application quality level.
• the Components. See "Adding an application to the application 

system", page 29.
• the Functional Scope. See "Defining Application Functional Scope", 

page 31.
• the Responsibility: see "Responsibilities", page 37.
• the application system Gantt chart. See "Application system Gantt 

chart", page 37.
• associated Attachments. See "Attachments", page 33.
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Responsibilities

Owner 

An owner should be defined on the application system. He/she is responsible for
application system technical and functional information He/she can be application
owner or portfolio manager.

Financial Controller

A financial controller should be connected to an application system. He/she is
responsible for defining application system financial information, in particular at
time of evaluation.

Business User

A business manager can be specified if necessary, but this is not mandatory.

Application system Gantt chart

The application system has its own life cycle. It is confronted with the life cycle of
its components so that possible conflicts in reports can be detected. The application
system Gantt chart therefore displays life cycle of the application system with that
of its components. 

See "Defining Application Life", page 38.

Evaluating Application Systems

Similarly to applications, the application manager can evaluate application systems
for which he/she is responsible on three criteria: business, functional and
technological. For more detailed information, see "Evaluating Application
Criticality", page 56.

The Portfolio Manager can evaluate the application assets he/she supervises by
creating an application portfolio and associating with it additional evaluation criteria.
See "Evaluating Application Assets", page 61.
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DEFINING APPLICATION LIFE

To enable detailed analysis of repository object evolution scenarios and the
associated costs, HOPEX IT Portfolio Management enables description, from an
object life, of the planning of steps in the object life cycle. 

 The object life is a set of time periods representing the updated 
calendar of object life cycle states.

An object life can be defined for:
• a business process
• an application
• a hardware item
• an initiative

Viewing Application Life (Gantt Chart)

An object evolving over time can take different states (preparation, production,
retirement, etc.).

The Object life enables viewing of the planning of these different states in the form
of a Gantt chart. 

To view the Gantt chart representing the different states of an application for
example:

1. Open the application properties.
2. In the properties of the application, click the drop-down list and select 

Characteristics.
3. Expand the Gantt section.
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Gantt chart example

The first line shows the synthesis of the life cycle of the application (here "Billing"),
with the sequence of different states. Under this line you access the details of the
time periods associated with each state (preparation, production, etc.).

Gantt Chart Report

On an application, a report in the form of a Gantt chart enables viewing of steps in
the application life cycle, its deployment and the technologies used. See "Analyzing
Application Life Cycle and Installations", page 47.

Specifying Object Life

Creating an object life

To create object life:
 The object life is a set of time periods representing the updated 
calendar of object life cycle states.

1. Right-click the object concerned and select New > Object Life.
The creation of object life dialog box appears.
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2. Specify the following characteristics:
• a Life Cycle which enables definition of the list of possible states of 

the object.
 For more information on proposed life cycles, see "Defining Life 
Cycles", page 24.

• a Begin Date and an End Date which enable positioning of the object 
life in time.

3. Click OK.

The object life appears in the Gantt chart of the application. 

From information on object life, the Gantt chart represents planning of the different
steps in time.

Updating the dates of the object life

By default, the different steps in the object life cycle are distributed in equal time
periods between object life begin and end dates.

These dates are accessible and can be modified in the application Gantt chart.

Accessing properties of a time period

In the Gantt chart, the pop-up menu of a time period presents commands specific
to the described application ("Billing" in our example), followed by the commands
relating to the time period itself. 

To access properties of a time period of the application life:
1. In the Gantt chart, right-click the time period.
2. In the time period pop-up menu, select Properties.
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DEFINING AND MANAGING TECHNOLOGIES

Application asset technologies can be created and managed by the Technology
Portfolio Manager or the Application Owner. They are then validated or rejected by
the Technology Manager. Their cost is determined by the Financial Controller.

Validation and updating of technologies is assured by workflows.

Creating a Technology

As is the case for applications, HOPEX IT Portfolio Management produces a
technologies navigation tree, accessible in the Inventory tab of the ITPM desktop.
The navigation tree displays the list of technologies and classes according to
different criteria:

• All technologies of the repository
• Technologies outside portfolio (those not belonging to any inventory 

portfolio)
• Technologies of the connected user portfolio

 This display corresponds to the "List" view. A hierarchical view of 
the Inventory tab is also available; it presents technologies according 
to their type and supplier.

To create a Technology:
1. On the desktop, click the navigation menu, then Inventory.
2. In the navigation pane, click the All Technologies folder.

The list of technologies appears in the edit area.
3. Click the New button.
4. In the dialog box that appears, indicate:

• its name 
• the owner library
• the editor

5. Click OK.

When a technology is created in HOPEX IT Portfolio Management, a workflow is
automatically started and a validation request sent to the Technology Manager, who
defines the enterprise Standard. See "Validating a Technology", page 44.

Accessing Technology Properties

To access technology properties:
1. In the list of repository technologies, select the required technology and 

click Properties.
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2. Click the drop-down list to access the following properties pages:
• Characteristics
• Version and installation
• Applications
• Cost
• Wall
• Generates reports
• BDNA

Characteristics

In this page you can specify:
• Identification of the technology:

• the Name of the technology
• the internal Code
• the Vendor
• Enterprise Standard: specified by the Technology Manager
• a Comment. 

• Official Life Cycle of the technology, with publication and support end 
dates of the supplier.

• Technology Type: IT service, operating system, platform, DBMS. A 
technology  can be connected to one or to several technology types. 

 New technology types can be created by the functional 
administrator only.

• Responsibility: this is the person or persons responsible for the 
technology:
• the management controller responsible for financial aspects of the 

technology
• the local correspondent who is the main referrer for the technology 

 This business role is not associated with a specific desktop.

• Gantt Chart presenting the technology life cycle. This is the life cycle 
within the organization; it can differ from the official life cycle specified 
by the supplier.
For more information on the object life cycle and its Gantt chart, see
"Viewing Application Life (Gantt Chart)", page 38.
For more information on the technology official life cycle, see "BDNA
properties in HOPEX", page 92.

• associated Attachments.

Applications

This page allows you to connect the technology to existing applications. For each
application you can indicate:

• Total expenses for the year
• Capital expenditure (CAPEX)
• Operating expenses (OPEX)
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Cost

In this page you can define costs linked to the technology. The definition of costs of
a technology is the same as for an application. See "Managing Application and
Application System Costs", page 51. 

An analysis report summarizes costs of the technology. See "Costs Report", page
43.

Wall

This page offers the possibility of chats with all those who have access to the
technology.

The first frame enables creation and selection of a thread of posts; the second frame
displays associated posts and enables reply.

 For more details on threads of posts, see the HOPEX Common 
Features guide, chapter "Communicating in HOPEX", section "Managing 
Threads of Posts". 

Generates reports

The Reporting page accesses available analysis reports on the technology.

Costs Report

Summarizes technology costs, by cost nature and by year.

Gantt Chart

Displays technology life cycle steps. See "Defining Application Life", page 38.

Detection of Conflicts

This report presents possible conflicts between the technology life cycle and the life
cycle of its dependent applications.

Rules Application

Displays modeling rules in cases where a rule is active.

Overview

Displays a summary of technology characteristics.

Importing Technology information from BDNA Technopedia™

By integrating BDNA Technopedia™ with HOPEX IT Portfolio Management solution,
HOPEX enables Enterprise Architects and Technology Portfolio Managers to get all
consistent and accurate information about IT assets from the Technopedia
repository.

See "Importing Technology information from BDNA Technopedia™", page 89.
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Validating a Technology

A validation workflow can be started:
• automatically 
• on request from the Portfolio Manager 

At technology creation

At creation of a technology, a task is automatically assigned to the Technology
Manager, who must validate or refuse the technology. The task appears in his/her
desktop, in which are displayed the objects for which he/she is responsible.

To validate a Technology:
1. Click the navigation menu then List of tasks.
2. Under To-Do List, select Technologies to Validate.

The list of technologies to be validated appears in the edit area.
3. Click the icon of the technology to be validated and select Validation > 

Accepted.

The Recommended command also validates the technology, but in a more
pronounced way, since it specifies that it is an expectation.

The Enterprise Standard attribute is modified depending on the workflow. This
attribute can take values:

• Recommended
• Accepted
• Prohibited
• Unknown

If a technology belongs to a "prohibited" or "unknown"supplier, it automatically
takes the same value. 

on demand

The Portfolio Manager can subsequently request a new validation of the technology.

He/she can also request financial validation from the Financial Controller responsible
for this technology.
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MANAGING DEPLOYMENTS

HOPEX IT Portfolio Management enables management of application
deployments.

Applications and Installations

HOPEX enables association of an application with one or several installations. A
software installation is supported by a site or server.

 A software installation represents use by a given population of an 
application over time. The installation is therefore associated with a life 
cycle which is specified at the time of its creation.

On the same site, an application is installed to offer different services to different
users. Each installation is therefore associated with several usage contexts which
enable specification of lists of functionalities available to different users.

 The usage context of an application or an application system 
enables specification of the list of functionalities offered to each 
population of users for a given installation over a period of time. Several 
contexts can be created for a given installation.

The application installation mechanism supplements the version management
functionality offered by HOPEX.

Consulting Application Installations

To access the installations of an application:
1. Open the application properties.
2. Select the Version and Installation page.

The list of installations associated with the application is displayed with: 
• deployment date
• planned retirement date

To access characteristics of installations of an application:
1. Select an installation.

The hostings and usage contexts associated with the installation appear
in the following sections.

In Context of Use you can define : 
• context begin date: 
• proposed functionalities retirement date 
• planned number of users

By clicking a context, you display in the following section:
• The list of functionalities associated with the context  (Implemented 

Functionality)
• The list of users of these functionalities (Consumer)
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Creating an Application Installation

Application installation on a site offers functionalities adapted to different
populations of users over a time period.

You can create a first installation at creation of the application, or create it later via
its properties pages.

To create an application installation:
1. Open the application properties.
2. Select the Version and Installation page.
3. In the Software Installation section, click the  New button.

The Creation of Software Installation dialog box opens.
4. Enter the name of the deployment.
5. Select the Deployment Life Cycle from the drop-down list of this field. 
6. Indicate:

• Start Date, corresponding to the effective deployment date
• End Date, which can correspond to the application production end 

date.
7. Select the Freeze the Source Object of the Software Installation to 

avoid modification of the deployed application.
 You cannot modify a locked application. If the application is to be 
modified, a new version must be created. 
 For more details on variations, see the HOPEX Common Features 
guide, "Handling Repository Objects", "Object Versions" chapters.

8. Click Next.
The add usage context dialog box opens.

9. In the Deployment Support drop-down list,  select the site or server 
that hosts the deployment. 

10. Click OK.
The new installation appears in the application properties. 

Creating an Installation Usage Context

The usage context of an application or an application system enables specification
of the list of functionalities offered to each population of users for a given installation
over a period of time. Several contexts can be created for a given installation.

To create a usage context of an application installation:
1. Open the application properties.
2. Select the Version and Installation page.

The list of installations associated with the application is displayed.
3. Select the installation that interests you.
4. In the Use Context section, click the  New button.

The Creation of Use Context dialog box opens. 
5. Specify the Life Cycle, Start Date and End Date of the context. 
6. Click Next.

The Add Consumer dialog box appears.
7. Click the Connect button to select users specific to the usage context.
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8. Click Next.
The add functionality dialog box appears:

9. Click the Connect button to select the functionalities that will be 
proposed to users in the usage context.

10. Click OK.
The new usage context appears in the properties of the deployed
application.

Analyzing Application Life Cycle and Installations

A report enables display in the same Gantt diagram of life cycle steps of the
application and its installations.

A second report indicates any conflicts between life cycles of these objects.

To access these reports:
1. Open the properties of the application concerned.
2. Select Reporting then.

• Gantt Chart to view life cycles of three objects
• Detection of conflicts to view any conflicts.

Detection of conflicts report on an application

Creating an Application System Installation

When we refer to application system installation, this means installation of all or
only certain of its components.
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You can create several installations for the same application system.

When you create an application system installation, the wizard allows you to
automatically create software installations for all application system components.
You can also manually define software installations to be associated with the
application system (see "Defining Application System Software Installations", page
48).

To run application system installation:
1. Open the properties of the application system.
2. Select the Installation page.
3. In the Application System Installation section, select New.
4. In the window that appears, enter:

• installation name
• installation start and end dates

5. Indicate if you want to install all components. In this case, the tool 
creates these automatically.

6. Click Next.
You can specify:
• the Consumers, in other words the users of the deployed application 

system.
• the Implemented Functions.

7. Click OK.

Application System Installation Contexts

A usage context is automatically associated with an application system installation
To this context you can connect consumers and implemented functions. 

 The usage context of an application or an application system 
enables specification of the list of functionalities offered to each 
population of users for a given installation over a period of time. Several 
contexts can be created for a given installation.

You can create several contexts for the same application system installation.

To add a context to an application system installation:
1. Open the properties of the application system.
2. In the Installation page, Application System Installation section, 

select the application system installation concerned.
3. In the Application System Installation Context section, select New.

The context appears in the section.
4. Select the context created and in the next section, indicate the 

Consumers of the context and the Implemented Functions.

Defining Application System Software Installations

To indicate manually which components are deployed in an application system
installation:

1. Open the properties of the application system.
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2. In the Installation page, Application System Installation section, 
select the application system installation concerned.

3. In the Software Installation section, select New.
4. From the listed components, select the application to be installed.

• If the selected application has no existing installation, create an 
installation. A context is automatically created for this installation in 
which the consumer is the installation of the application system.

• If the application presents existing installations, select the required 
installation. A context is automatically created for this installation in 
which the consumer is the installation of the application system.
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MANAGING APPLICATION VERSIONS

HOPEX IT Portfolio Management enables management of different versions of
applications.

Managing Versions

Application versions enable creation of application variants. Each version constitutes
a new application which inherits elements of the application from which it is derived.
The user can then indicate the differences to be added to the new application, by
modifying or replacing obsolete elements.

The system of versions therefore enables follow-up of updates of an application over
time. 

 For more details on versions, see the HOPEX Common Features 
guide, "Handling Repository Objects", "Object Versions".

 To use variations, select the Business Process and Architecture 
Modeling option, Activate Variations.

If you create a version of an application, the application is automatically locked. To
modify the application, you must create a new version or unlock the application.

 The version of an application is created without an object life, even 
if the parent had one.

Unlocking an application

To unlock the parent object that has been versioned:
 Click the icon of the initiative and select Manage > Unlock Object.

This command appears if you are authorized to unlock protected objects.

For more information on locks, see lock management in chapter "Managing
Transactions" of the HOPEX Administration - Supervisor guide. 
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MANAGING APPLICATION AND APPLICATION SYSTEM 

COSTS

The aim of modeling costs with HOPEX IT Portfolio Management is to be able to
compare the cost of different components and to compare the different evolution
scenarios on identical financial criteria.

To be able to take account of the time (past and future), the cost of a component is
represented by a fixed part and a periodic part.

For example, a purchase price is specified in a fixed part, 
and annual maintenance in a periodic part.

Finally, costs are characterized by different criteria that enable more detailed
comparison. Criteria are:

• the type to distinguish investment costs.
• the nature to isolate costs of infrastructure, license, service or 

manpower.
• life cycle of the component concerned.

Cost Calculation Principles

Each fixed expense is associated with an amount and a date. 

Each periodic expense is associated with an initial amount, a start date, and the
amount and periodicity of timespots. 

 For more details on modeling of costs, see "Creating a fixed 
expense", page 53 and "Modifying a periodic expense", page 53.

The cost of the object can be calculated in the absolute, or in the context of an
initiative of a portfolio. In the case of an initiative, sums are calculated between
begin date and end date of the portfolio.

We assume for example that retirement of an application 
starts in July with a decreasing periodic cost. The periodic 
cost is 500€ and the decreasing cost -100€.

Begin Date End date Period cost Total cost 
obtained

7/1/2012 30/07/2012 500 500

7/1/2012 8/1/2012 400 900 

7/1/2012 9/1/2012 300 1200 
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The cost calculation formula proposed as standard in HOPEX  is based on fixed and
variable cost characteristics. 

Specifying Costs Components

Costs on a component can be specified by:
• a user with "Financial Controller" role, who has been declared 

responsible for the component in question;
• the Application Portfolio Manager:

 To define those responsible for an application, see "Application 
Characteristics", page 30.

You can define costs on the following  components HOPEX :
• Applications
• Application deployments
• Initiatives

One or several cost lines can be associated with a component. 
 A cost line enables identification of cost kind and type.

A cost line is characterized by:
• a type :  operating or capital.
• a nature: infrastructure (for a deployment), license (for an application), 

service, manpower.
• l’state of the life cycle of the component concerned, such as 

specification or development phases.

Associated with a cost line can be:
• a periodic expense
• one or several fixed expenses

Creating a cost line

To associate costs with an application for example, you must begin by creating a
cost line. 

You can create cost lines singly, or automatically create three cost lines
corresponding to the three cost natures possible for an application: license, service,
manpower. 

To create a cost line for an application:
1. Click the icon of the application and select Properties.

7/1/2012 10/1/2012 200 1400

7/1/2012 11/1/2012 100 1500 

7/1/2012 12/1/2012 0 1500 

Begin Date End date Period cost Total cost 
obtained
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2. In the properties page, click Costs.
3. In the Cost linesection, click  New.

The Creation of a cost line box opens.
4. To create a single cost line, select option Create only one cost line.
5. Click Next.
6. Specify the Nameof the cost line.
7. Select the Cost Type.. 
8. Select the Cost Nature.
9. Select the State of the application life cycle. 

 The states proposed in the drop-down list are states of the life cycle 
associated with the object life.

10. Click Next.
The periodic expenses creation dialog box opens.

 Fixed expenses, which can be multiple, are separately defined. For 
more details on fixed expense creation, see "Creating a fixed expense", 
page 53.

11. Define the periodic cost and click Next.
 For more details on fixed expense creation, see "Modifying a 
periodic expense", page 53.

12. Click OK.
The new cost line appears in the Cost Line.

Creating a fixed expense

Fixed expenses associated with a component are accessible from the component
properties pages, in the Costs tab. 

To create a new fixed expense on an application from a cost line:
1. Click the icon of the application and select Properties.
2. In the properties page, click Costs.
3. In the Cost Line section, select the cost line that interests you.
4. In the Fixed Expenses section, the list of fixed expenses associated 

with the cost line appears. In this section, click the New button.
The Creation of Expense dialog box opens.

5. Specify:
• the Name of the expense
• the Date of the expense,
• the Amount of the expense.

6. Click OK.
The new expense appears in the Fixed Expenses section.

Modifying a periodic expense

To modify characteristics of a periodic expense associated with an application:
1. Click the icon of the application and select Properties.
2. In the properties page, click Costs.
3. In the Cost Line section, select the cost line that interests you.
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4. Columns specific to the periodic expense are associated with the cost 
line:
• Periodic cost
• Periodicity
• Up/Down Amount

5. Click the column to be modified and enter the new value.
 If you indicate a negative amount, at each time period the amount 
will be deducted from the periodic cost until this reaches zero.

Application System Costs

The cost of an application system can be calculated from its different components
or or globally:

• When an application used by the application system is specified 
"Application", the cost of this application is not charged to the application 
system, in other words the cost relates only to the application.

• When an application used is specified "Component", the cost of this 
application is charged to the application system and is no longer listed on 
the application. 

To indicate that an application is used by the system as a component:
1. Open the properties of the application system.
2. Click the drop-down list then Characteristics.
3. In the Component section, select Application Component to display 

applications making up the application system
4. Select the required application , and in the Aggregation Type column, 

select "Component".

Specifying a Currency

At the level of each HOPEX environment the currency used can be specified. The
monetary numeric format adapts as a result.

To modify currency:
1. In the HOPEX installation folder, double-click the "Administration.exe" 

file.
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2. Access your work environment.
3. Right-click the desired environment and select Options > Modify.

The options window appears.
4. In the navigator on the left, expand the Installation folder and select 

Currency.
5. On the right indicate the currency.
6. Click OK.

The format of costs is modified depending on the specified currency. Note also that
the format of figures depends on the interface language.

Analyzing Costs

A report summarizes costs of applications, their versions and deployments. 

To view the report on costs of an application or an application system:
1. Open the properties of the application concerned.
2. Click the drop-down list then Reporting then Cost report.
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EVALUATING APPLICATION CRITICALITY

Criticality of an application is assessed related to criteria linked with the business,
to functionalities covered and to technologies used. Evaluation involves different
user types. For more details on users, see "Profiles of HOPEX IT Portfolio
Management", page 12.

Evaluation Criteria

Evaluation of an application relates to:
• its Business Value enabling evaluation of the nesting level of the 

application in enterprise production. 
• Level 1: operational business processes will be stopped if the 

application no longer functions and a workaround solution exists. 
• Level 4: major production processes will be stopped in the case of 

application malfunction with no workaround solution.
• its Business Value enabling evaluation of the support level of the 

application in enterprise process. 
• Level 1: low level
• Level 4 the application is critical from a functional viewpoint, since it 

supports key processes on its own.
 For more details on businesses addressed and functionalities 
covered, see "Defining Application Functional Scope", page 31.

• its Technology enabling assessment of evolution possibilities of the 
application from the techniques that support it. 
• Level 1: technology is frozen
• Level 4: corresponds to a flexible and upgradable technological 

platform.
 For more details on technologies, see "Specifying Technologies", 
page 32.

Creating an Assessment Measure

You can evaluate an application at precise moments, by creating a new evaluation
measure each time.

To create an evaluation measure:
1. Click the icon of the application to evaluate and select Properties.
2. In the properties drop-down list, click the Assessment page.
3. Click theNew Measure button.

The TaggedValue (criterion) creation dialog box opens.
4. Indicate the value of each criterion as well as the evaluation end date.
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From evaluation data, a report allows you to classify applications of the installation
in a matrix and to rapidly identify the applications to be upgraded. See "Accessing
Reports Available for a Transformation", page 74.
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EVALUATING APPLICATION ASSETS

Each application manager can evaluate applications for which he/she is responsible on three
criteria: business, functional and technological. See "Evaluating Application Criticality", page 56.

The Portfolio Manager can evaluate the application assets he/she supervises by creating an
application portfolio and associating with it additional evaluation criteria.

The numerous reports proposed by HOPEX IT Portfolio Management to analyze applications
before starting the transformation phase.

The following points are covered here:

 "Describing Inventory Portfolios", page 62
 "Defining Transformation Portfolio Criteria", page 65
 "Using Timelines", page 71
 "Analyzing an inventory portfolio", page 73
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DESCRIBING INVENTORY PORTFOLIOS

An inventory portfolio groups a set of applications.

Creating a portfolio with  consists of defining all the information (comparison
criteria, timelines, etc.) that will then allow you to select initiatives to be
implemented. 

 A portfolio enables representation of all investments of an 
enterprise (or department) necessary to carry out changes required to 
achieve strategic objectives. It comprises a set of initiatives to be 
compared based on comparison criteria associated with the portfolio.

 An initiative is a portfolio element corresponding to an investment 
program identified by the enterprise (or department) to achieve 
strategic objectives.

You can also create a inventory portfolios for technologies, as Technology Portfolio
Manager. The technology portfolio definition uses the same methods than
applications portfolios.

Creating an inventory portfolio

HOPEX IT Portfolio Management proposes two types of portfolios:
• The inventory portfolio: comprising different applications, it enables 

follow-up of a given set of applications.
• The transformation portfolio: this intervenes after the inventory and 

evaluation phases and comprises initiatives (representing applications) 
and can include several initiatives for the same application in order to 
measure the option costs of different scenarios. See "Transforming an 
application portfolio", page 75.

To create an inventory portfolio:
1. Connect to  HOPEX IT Portfolio Management as Application Portfolio 

Manager.
2. Click the navigation menu, then Inventory.
3. In the navigation pane, click All application portfolios. 

The list of application portfolios appears in the edit area.
4. In the edit area, click New.

The new portfolio appears in the list. You can open its properties to define
its characteristics.

Defining Inventory Portfolio Content

All elements of a portfolio are accessible from its properties pages.

To access application portfolio properties pages:
1. Click the navigation menu, then Inventory.
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2. In the navigation pane, click All application portfolios. 
The list of application portfolios appears in the edit area.

3. Click the portfolio you want to study and click Properties.
Portfolio properties pages appear.

Portfolio characteristics

Portfolio characteristics are broken down into five groups:
• Identification: name, portfolio type, study dates, comment.
• Portfolio Criteria: see "Defining Transformation Portfolio Criteria", 

page 65
• Responsibility: displays person responsible for the portfolio
• Sub-Portfolios 
• Timeline: see "Using Timelines", page 71.
• Report: enables creation of analysis reports on the portfolio. See 

"Accessing Reports Available for a Transformation", page 73.

Inventory

This page enables listing of portfolio applications and evaluation of their criticality.
See "Evaluating Application Criticality", page 56.

Evaluation

This page enables definition of values of criteria associated with applications. See
"Evaluating Portfolio Applications", page 68.

 A criterion is a reference element used to compare initiatives in a 
portfolio. Criterion values can be predefined.

Generates reports

This page displays the different dynamic analysis reports of the portfolio. 

Generating the Portfolio Business Capability Map

A business capability map reflects functional coverage of existing application assets.
For more details, see "Defining Business Capabilities", page 23.

To generate a business capability map from a portfolio:
1. Right-click the portfolio concerned and select Properties.

The properties dialog box of the portfolio appears.
2. Click the drop-down list then Reporting then Business Capability 

Map.

The diagram positions portfolio applications in areas that represent business
capabilities. It therefore reflects functional coverage of portfolio applications.

 For more information on Business Capability Map, see "Defining 
Business Capabilities", page 23.
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From this diagram a report is generated presenting the functional coverage changes
of an application portfolio over time. See also "Analyzing an inventory portfolio",
page 73.

Example of Business Capability Map
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DEFINING TRANSFORMATION PORTFOLIO CRITERIA

You can compare initiatives defined in a portfolio based on common criteria
associated with the portfolio.

 A criterion is a reference element used to compare initiatives in a 
portfolio. Criterion values can be predefined.

To view criteria associated with a portfolio: 
1. Right-click the portfolio concerned and select Properties.

The properties dialog box of the portfolio appears.
2. Click the drop-down list then Characteristics.
3. In the characteristics, expand the Portfolio Criteria section.

To define portfolio criteria, you can:
• Use criteria already existing in the repository.
• Create new criteria and associated values.

 Criteria are defined from the MetaClass (object type) 
TaggedValue. Certain dialog boxes use this term rather than 
Criterion.

Using Existing Criteria

To define criteria for comparison of applications of a portfolio using existing criteria:
1. Right-click the portfolio concerned and select Properties.

The properties dialog box of the portfolio appears.
2. Click the drop-down list then Characteristics.
3. In the characteristics, expand the Portfolio Criteria section.
4. In the section, click the New button.

The search pane is displayed with a list of criteria already defined. 
5. Select the criteria that interest you.
6. Click Add.

Each selected criterion is displayed in portfolio characteristics.

Using Existing Criteria

Standard criteria are proposed to process costs modeled on objects and initiatives.
 For more details on modeling of costs, see "Managing Application 
and Application System Costs", page 51.
 For more details  on initiative modeling of costs, see "Modeling 
Initiative Costs", page 81.
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Standard criteria enabling analysis of costs declared on initiatives as a function of
their type and nature are the following:

• For type: 
• Capital expenses
• Operating expenses

• For nature:
• Infrastructure costs
• Software licenses costs
• Manpower costs
• Service costs

The names of standard criteria enabling analysis of costs declared on objects carry
the extension "Reference", for example "Reference Costs".

Given that certain criteria are automatically calculated, they cannot be modified
from the Inventory or Assessment tabs of the portfolio.

 For more details, see "Evaluating Portfolio Applications", page 68.

Creating a New Criterion

To create new criteria for portfolio application comparison:
1. Open the properties pages of the portfolio and select Characteristics.
2. In the characteristics, expand the Portfolio Criteria section.
3. In the section, click the New button.

The TaggedValue (criterion) creation dialog box opens.
4. Indicate the name of the site and click OK.

The new criterion appears in the list of portfolio criteria.

Defining criterion format

Specification of type and format of a criterion (or TaggedValue) is identical to that
of a MetaAttribute. For more details on declaration of criterion format, see chapter
"MetaAttributes" of the Studio guide.

To define characteristics of a criterion:
1. Select the criterion and click Property.
2. Click Characteristics.
3. In the MetaAttribute Type field, indicate the type that will take the 

criterion values.

MetaAttribute Type Meaning

String Alphanumeric, the value of the MetaAttribute 
Length attribute should then be specified

DateTime Date

VarChar ASCII text

VarBinary Binary text (reserved)
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4. In the MetaAttribute Format field, indicate the Format that will take 
the criterion values. Possible values are:
• Standard: for character strings
• Currency: for currencies
• Enumeration: for a list of character strings with predefined values
• Enumeration (Opened): for a list of character strings open to the 

user 
• Duration: for dates
• Percent : to enter a percentage
• Double : to enter a number
• Object : to enter an object
• Signed Number : to enter a number possibly negative. In this case, 

MetaAttribute Type must be  Short, Long, Double or Float.
 The following formats are recognized in analysis reports: 
Standard, Enumeration and Signed Number. 

5. Click OK.

To define values associated with a criterion of Enumeration format:
1. Open the properties pages of the criterion.
2. Select External Values.
3. Click the New to create new values.

Defining Criterion Aggregation Rules

Aggregation of a criterion enables definition of calculation rules that will be applied
to application values to obtain the criterion value on a portfolio. In this way you can
compare portfolios.

To define criterion aggregation rules:
 Open the properties pages of the criterion.
 Click the drop-down list then Characteristics.

Boolean Boolean (0 or 1)

Short Integer (0-65535)

Long Integer (0- 4294967295)

Binary Binary (reserved)

Double Integer (0- 18446744073709551616) 

Float Floating number

MetaAttribute Type Meaning
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Aggregation policies proposed as standard are: 
• Minimum
• Maximum
• Average
• Sum

For example, the Cost criterion associated with a portfolio 
can be obtained by calculating the average cost of 
initiatives making up the portfolio, or the sum of costs of 
each of the elements.

To fix more specific aggregation rules, the aggregation policy can be defined by a
Macro. The name of the macro is defined in the Aggregation Macro column.

 For more information on Macros in HOPEX, see the  guide All 
about starting with APIs.

The result of aggregation of different criteria is accessible in the Aggregation
Value column.

Evaluating Portfolio Applications

Portfolio applications are evaluated related to different portfolio criteria.
 Standard criteria relating to costs are automatically calculated, they 
cannot therefore be modified in this tab. For more details on these 
criteria, see "Using Existing Criteria", page 65.

Accessing applications to be evaluated

To access evaluations of all portfolio applications:
1. Open the properties pages of the portfolio.
2. Click the drop-down list then Evaluation.

The list of evaluations of all portfolio applications according to different
criteria is displayed. 

3. To define a criterion value on an application, such as a cost, select the 
application concerned and click in the criterion column.

Generating a PDF or Excel evaluation data file

The PDF and Excel allow you to generate PDF and Excel files of evaluation results.
 For reasons of readability, the PDF file contains a maximum 12 
columns.

Generating an instant report on evaluation data

Instant reports allow you to carry out drill-down analysis on evaluated objects. They
provide greater detail depending on specific analysis perspectives (quantitative,
time, etc.).

To generate an instant report on a list of evaluated applications:
1. Open the properties pages of the portfolio.
2. Click the drop-down list then Inventory.
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3. In the list of applications, select those to be analyzed.
If you do not select an application, by default the report covers all
applications.

4. Click Instant Report.

 If necessary, click  to display the hidden commands.

5. Select the required analysis type, for example "Breakdown". 
6. Click OK. 
7. In the list of possible grouping criteria, select "Costs".

For all selected technologies, you receive the cost breakdown according
to their levels. 

For further information on instant reports, see the HOPEX Common Features
guide, "Generating documentation", "Launching instant reports on lists".

Portfolio costs report

A report automatically displays the global costs of applications contained in a
portfolio.

To access the portfolio cost report:
1. Open the properties of the portfolio.
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2. Select Reporting > Costs Report. 

An analysis report also summarizes costs of applications and of their versions and
deployments between the portfolio start date and end date. 
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USING TIMELINES

The analysis phase of portfolio applications is based on timelines.
 A timeline presents key timespots of the organization from fixed 
dates or defined periods.

A timeline is an object specific to the enterprise and can be referenced by portfolios
or master plans.

The timeline associated with an application portfolio is used in time distribution of
the application portfolio business capability map. See "Generating the Portfolio
Business Capability Map", page 63.

To view timelines associated with a portfolio: 
1. Open the properties pages of the portfolio.
2. Click the Reference timeline tab.

This section is in two parts:
• Reference timeline: indicates a global calendar showing a certain number 

of timespots over a given time period. You can define a new timeline or 
connect an existing timeline.

• Owned timeline: corresponds to timeline milestones; milestones appear 
when you select a timeline in the upper part.

The above example presents a timeline for the upgrade of 
application assets. Phases of deletion of obsolete 
applications are synchronized with phases of deployment of 
new applications.
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Creating a timeline

To create a timeline:
1. In the first frame of the Reference timeline section, select New.

The Timeline creation dialog box appears.
2. Enter the name of the timeline.
3. Click OK.

The timeline is created and added to the list of portfolio timelines.

Defining timespots

The Timeline diagram allows you to define the different key events that make up
the timeline, as well as their dependency links.

To create a new timeline diagram: 
1. Click the icon of the timeline and select New > Timeline Diagram.

An empty diagram appears.

To create an  TimeSpot:

1. In the insert toolbar, click the Timespot   button, then click in the 
diagram.
The Add TimeSpot dialog box appears.

2. Indicate the name of the timespot  and click Create. 
The timespot appears in the diagram.

To specify time links between timespots, you will create a sequence flow:

1. Click the Sequence Flow button 
2. Click the timespot representing the start step, and holding the mouse 

button down, draw a line to the timespot representing the next step.
3. Release the mouse button.

A directional link from one timespot to the next appears in the diagram.
Previous and next timespots also appear in timespot Properties, in the
Characteristics page.

Dating a timespot

A timespot can be associated with a precise date or a time interval. The time interval
is defined by a date at earliest and a date at latest.

To define timeline timespot dates: 
1. Open the properties pages of the timeline.
2. Select the Characteristics page.
3. In the Owned TimeSpot section, you can date timespots.

 You can also specify sequence flows.
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ANALYZING AN INVENTORY PORTFOLIO

HOPEX IT Portfolio Management provides predefined report templates for
application portfolio analysis.

Accessing Reports Available for a Transformation

The different report templates proposed as standard by  HOPEX IT Portfolio
Management are designed to compare initiatives of a portfolio based on specific
criteria. Different report types offer different analysis possibilities. 

To access existing reports on an application portfolio:
1. Open the properties of the report.
2. Click the drop-down list then Reporting.

You have access to the following reports:
• Cost report: cost analysis of portfolio applications.
• Business capability map: shows the distribution of applications in the 

business capabilities.
• Gantt Chart: presents the lifelines of three objects
• Timed business capacity map: shows the functional coverage changes 

of an application portfolio over time.  See "Generating the Portfolio 
Business Capability Map", page 63.

• List of applications: presents functional characteristics of portfolio 
applications as a matrix.

• Application positioning: shows the distribution of applications with 
respect to the business function addressed, functionalities covered 
and the technologies used. This presentation enables rapid 
identification of applications to be developed.

• Application TIME report: uses the Gartner TIME model to analyze the 
business value of applications.

• Software technology support alert: used to track the obsolescence of 
technologies. See also "BDNA properties in HOPEX", page 92.



74 MEGA IT Portfolio Management

3



4

75

TRANSFORMING AN APPLICATION PORTFOLIO

Portfolios enable management of transformation scenarios. In a scenario, each application - or
technology for a technology portfolio manager - can be associated with one or several initiatives.
The initiative then enables description of:

 The "alternative" life of the applications related to the reference life described on 
the application itself. You can therefore represent early retirement or extended 
maintenance for example.

 Costs relating to this "alternative" together with any other criteria, according to 
formalization of the portfolio.

A certain number of reports allows you to analyze transformation portfolios. 

 For more details on operation of reports, see the "Generating 
documentation > Accessing reports in HOPEX solutions" chapter in the 
HOPEX Common Features guide.

When a scenario is accepted, the life cycles of accepted initiatives replace the life cycles of
applications from which they are derived.

The following points are covered here:

 "Describing a Transformation Portfolio", page 76
 "Defining Initiatives", page 79
 "Using Scenarios", page 83
 "Analyzing a transformation portfolio", page 85



76 MEGA IT Portfolio Management

4

DESCRIBING A TRANSFORMATION PORTFOLIO

Creating a portfolio with HOPEX IT Portfolio Management  consists of defining
all the information (comparison criteria, timelines, etc.) that will then allow you to
select initiatives to be implemented. 

Creating a Transformation Portfolio

New portfolio

To create a transformation portfolio:
1. Connect to  HOPEX IT Portfolio Management as Application Portfolio 

Manager.
2. Click the navigation menu, then Transformation.
3. In the navigation pane, click All transformation portfolios. 

The list of transformation portfolios appears in the edit area.
4. In the edit area, click New.

The new portfolio appears in the list. You can open its properties to define
its characteristics.

Transforming an inventory portfolio

You can transform an inventory portfolio to a transformation portfolio. 

To modify inventory profile type:
1. Click the navigation menu, then Inventory.
2. In the navigation pane, click All application portfolios. 

The list of application portfolios appears in the edit area.
3. Select the portfolio concerned and click Properties

The properties dialog box of the portfolio appears.
4. In the Characteristics page, in the Identification section, Portfolio 

Type field, select "Transformation".
The portfolio now appears in the list of transformation portfolios.

Creating a Sub-Portfolio

To be able to closely study development hypotheses, you can divide a portfolio into
sub-portfolios, each subject to different scenarios.

To create a sub-portfolio:
1. Click the navigation menu, then Transformation.
2. In the navigation pane, click All transformation portfolios. 

The list of transformation portfolios appears in the edit area.
3. Select the portfolio concerned and click Properties

The properties dialog box of the portfolio appears.
4. In the Characteristics page, expand the Sub-Portfolio section.
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5. Click New.
 If a scenario is associated with a main portfolio, it is not inherited 
by the sub-portfolio.

Defining Transformation Portfolio Content

All elements of a portfolio are accessible from its properties pages.

To access transformation portfolio properties:
1. Click the navigation menu, then Transformation.
2. In the navigation pane, click All transformation portfolios. 

The list of transformation portfolios appears in the edit area.
3. Select the portfolio concerned and click Properties

The properties dialog box of the portfolio appears.

Portfolio characteristics

Portfolio characteristics are broken down into five groups:
• Identification: name, portfolio type, study dates, comment.
• Portfolio Criteria: see "Defining Transformation Portfolio Criteria", 

page 77
• Responsibility: displays person responsible for the portfolio
• Sub-Portfolios 
• Timeline: see "Using Timelines", page 71.
• report: enables creation of analysis reports on the portfolio. See 

"Analyzing a transformation portfolio", page 85.

Transformation

This page enables determination of portfolio initiatives and the associated values.
See "Defining Initiatives", page 79.

Evaluation

This tab displays the list of evaluations of all portfolio initiatives according to
different criteria. See "Assessing Initiatives", page 81.

Generates reports

This page displays the different dynamic analysis reports of the portfolio. 

Defining Transformation Portfolio Criteria

You can compare initiatives defined in a portfolio based on common criteria
associated with the portfolio.

 A criterion is a reference element used to compare initiatives in a 
portfolio. Criterion values can be predefined.
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Definition of transformation portfolio criteria is done in the same way as for an
inventory portfolio. See "Defining Transformation Portfolio Criteria", page 65.

Defining a timeline

Phases of analysis and implementation of a portfolio are based on timelines. 
 A timeline presents key timespots of the organization from fixed 
dates or defined periods.

To define a timeline for a portfolio, see "Using Timelines", page 71.
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DEFINING INITIATIVES

An initiative is associated with an enterprise repository object. 
 An initiative is a portfolio element corresponding to an investment 
program identified by the enterprise (or department) to achieve 
strategic objectives.

With HOPEX IT Portfolio Management, this object can be:
• an application
• an application deployment
• a technology

Several initiatives can be grouped in an initiative group to simplify portfolio
management.

 An initiative group is a set of consistent investment programs 
designed to simplify portfolio analysis and follow-up.

Creating an Initiative

Creating an initiative from an application

To add an initiative to a transformation portfolio:
1. Click the navigation menu, then Transformation.
2. In the navigation pane, click All transformation portfolios. 

The list of transformation portfolios appears in the edit area.
3. Select the portfolio concerned and click Properties

The properties dialog box of the portfolio appears.
4. Click the drop-down list then Trasformation.
5. In the Transformation Initiatives section, click New.

The initiative creation dialog box appears.
6. In the Element with Initiative field, find in the list of applications that 

from which you want to create an initiative.
7. Click OK.

Initiative name

By default the initiative carries the name of the object from which it is derived: it is
recommended that you rename it.

To change the name of an initiative:
 Click the name, press the <F2> key and enter the new name.
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Defining Initiative Characteristics

To access information relating to initiatives:
1. Right-click the portfolio concerned and select Properties.

The properties dialog box of the portfolio appears.
2. Click the drop-down list then Transformation.
3. In the Transformation Initiatives section, select the initiative 

concerned and click Properties.
4. Select the Characteristics page.

The object to which the initiative relates appears in the Element with
Initiative box.

Specifying decision-making information

Decision-making information is specified in the following boxes:
• Decision, which can take values: 

• Accept
• Reject
• In progress

• Decision-Maker and Decision-Maker User.

Specifying timespots

Initiatives can be situated chronologically from timespots of the timeline associated
with the portfolio.

 For more details on timelines connected to a portfolio, see "Using 
Timelines", page 71.

The Characteristics page of an initiative presents:
• Starting Timespot and Ending Timespot, define the limits of the time 

period on which the initiative is planned.
• Timespot, defines the date at which the initiative is planned.
• Life Cycle Status of the entity that is the subject of the initiative. The 

values proposed depend on life cycle selected for initiative life.
 For more details on object life, see "Specifying Object Life", page 
39.

Specifying Initiative Life

To model component development scenarios of your portfolio without impacting the
life of components, you will use initiatives and associate an object life to each of
these.

 The object life is a set of time periods representing the updated 
calendar of object life cycle states.
 For more details on object life, see "Viewing Application Life (Gantt 
Chart)", page 38.
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Initializing initiative life

To create an object life on an initiative: 
1. Open the properties dialog box of the owner portfolio.
2. Select the Transformation page.

The Transformation Initiatives displays the list of portfolio initiatives.
3. Select the initiative and click Property.

The properties dialog box of the initiative appears.
4. In the Characteristics page, expand the Gantt section.
5. Click the Initialize Object Life button. This button is visible if the 

initiative does not hold an object life.  
 For more details on object life creation, see "Specifying Object 
Life", page 39.

Updating object life from an initiative

The different component development scenarios of a portfolio are studied through
initiatives connected to one or several scenarios. When a scenario is adopted, you
can automatically update the life of objects associated with portfolio initiatives from
the initiatives. See "Validating a scenario", page 84.

Modeling Initiative Costs

To view costs defined on an initiative:
1. Open the properties dialog box of the owner portfolio.
2. Select the Transformation page.

The Transformation Initiatives displays the list of portfolio initiatives.
3. Select the initiative concerned and click Properties.

The properties dialog box of the initiative appears.
4. Select the Costs page.

 For more details on principles of modeling costs of components and 
initiatives, see "Cost Calculation Principles", page 51.

Assessing Initiatives

Portfolio initiatives are assessed related to different portfolio criteria.
 Standard criteria relating to costs are automatically calculated, they 
cannot therefore be modified in this tab. For more details on these 
criteria, see "Using Existing Criteria", page 65.

To access initiatives of all portfolio applications:
1. Open the properties pages of the portfolio.
2. Select the Transformation page.

The matrix for assessment of all portfolio initiatives according to different
criteria is displayed. 

3. To define the value of a criterion, such as a cost, on an initiative, select 
the initiative concerned and click in the criterion column.

4. Specify values of the different criteria on each initiative.



82 MEGA IT Portfolio Management

4

5. Click OK.
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USING SCENARIOS

Several initiatives can relate to the same application, in the same portfolio, to
represent different hypotheses (exclusive between themselves) of the same
application.

scenarios can then be created by selection of a set of initiatives to be produced. The
different scenarios created can be compared by means of specific reports:

 A scenario is a projection in time of development of real objects 
through initiatives.

Creating a Scenario

A scenario is a coherent set of initiatives enabling costing of a hypothesis in a
transformation portfolio.

To create a scenario on a portfolio:
1. Click the navigation menu, then Transformation.
2. In the navigation pane, click All transformation portfolios. 

The list of transformation portfolios appears in the edit area.
3. Select the portfolio concerned and click Properties
4. Select the Transformation page.
5. Expand the Transformation scenarios section.
6. Click New.

The scenario is created with a default name. It is also automatically
connected to initiatives of the portfolio.

You can open its properties to modify its name if necessary or to define its
properties.

Accepting or Rejecting Scenario Initiatives

An initiative must be accepted in order to be taken into account in a given scenario.
Conversely, an initiative must be rejected if you want the scenario to ignore it.

To define initiatives to be taken into account in a scenario:
1. Open the properties pages of the portfolio you want to study.
2. Select the Transformation page.
3. In the Transformation Scenario frame, select the required scenario.

The list of initiatives connected to the scenario appears in the Initiatives
matrix.
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4. In the matrix, click the cells at intersections of initiatives and scenarios 
and select one of the following values:
• In progress: the initiative is under study, it is integrated in the 

scenario
• Rejected: the initiative is not taken into account in the scenario
• Accepted: the initiative is integrated in the scenario

Analyzing Scenarios

Analysis of different scenarios is possible using analysis reports. For more
information on analysis reports, see "Example of Scenario Comparison Report",
page 85.

Validating a scenario

After scenario analysis, you can validate or reject scenario changes. When you have
validated scenario changes, the life cycles of initiatives accepted in the scenario
replace the life cycles of applications from which they are derived.

To validate scenario changes:
1. Open the properties of the portfolio containing the scenario.
2. Select the Transformation page.
3. In the Scenarios of Transformation section, select the scenario to be 

validated.
4. In the Decision field, select "Accepted".
5. Click the Validate Transformation button. 

A message requests confirmation.
6. Click Yes to validate changes.
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ANALYZING A TRANSFORMATION PORTFOLIO 

HOPEX IT Portfolio Management provides predefined report templates for
transformation portfolio analysis.

Accessing Reports Available for a Transformation

Different report types offer different analysis possibilities. 

To access existing reports on a transformation portfolio:
1. Open the properties of the report.
2. Click the drop-down list then Reporting.

You have access to the following reports:
• Gantt Chart
• All comparison scenarios 
• TCO of applications with scenario forecasts
• Number of applications per year
• Obsolete applications per year

Example of Scenario Comparison Report

A scenario enables grouping of a coherent set of initiatives to then enable
comparison on criteria associated with the portfolio.

 A scenario is a projection in time of development of real objects 
through initiatives.

This report enables comparison of costs of different scenarios between two dates.
Either the scenarios belong to the same portfolio, or the report is built from a
scenario. In this case, costs carried by initiatives of the scenario are compared with
costs of real objects associated with initiatives.

Costs are compared according to their nature: 
• infrastructure
• licenses
• service
• manpower 

Costs are compared according to their type: operating or capital.



86 MEGA IT Portfolio Management

4



5

89

IMPORTING TECHNOLOGY INFORMATION 
FROM BDNA TECHNOPEDIA™

BDNA Technopedia™ is a large repository of technology market information. It provides an up-to-
date IT reference catalog of software and hardware information. HOPEX IT Portfolio
Management provides an integration tool with BDNA Technopedia™, allowing Enterprise Architects
and Technology Portfolio Managers to take full benefit of this information and make more accurate
decisions on their IT asset. 

This chapter presents how to use the BDNA connector and import Technopedia™ data in HOPEX.

 "Presentation of the BDNA Connector", page 90
 "Using the BDNA Connector", page 93
 "Automatic Updating and Alert", page 96
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PRESENTATION OF THE BDNA CONNECTOR

Use Case in HOPEX ITPM

In ITPM solution, the BDNA Connector is available to the Functional Administrator.
He is in charge of importing data from BDNA. He can initialize a new repository by
importing software technologies from BDNA Technopedia™ and use the Functional
Administration Desktop to manage automatic update workflows and alert tools.

The Technology Portfolio Manager (TPM) is responsible for software technologies
and their life cycle. He can include his software technologies in the scope of the
automatic update in order to be notified automatically of any changes. He can also
send the Functional Administrator a request to prepare the import of new software
technologies from BDNA.

The Application Portfolio Manager should subscribe to the standard notification on
sensitive software technologies that are used by his applications. Thus, when these
software technologies are updated by automatic or manual import from BDNA
properties, he will receive a notification of the change. He will analyze the impact
and decide how to proceed (keep the software technology, use a new version or
change it). 

Prerequisite Conditions

The BDNA Connector is available with HOPEX IT Portfolio Management and
requires the BDNA license that you will specify in the authentication settings.

To be able to connect to BDNA Technopedia™, you must set the Data Exchange
options related to exchanges between HOPEX and third party tools.

To define the required options:
1. Start HOPEX Administration.
2. In the navigation tree, right-click the HOPEX site name and select 

Options > Modify.
The site options window opens.

3. Expand the Data Exchange > Import folder.
4. Click the BDNA folder.
5. Enter information to access BDNA API (provided by BDNA):

• BDNA API URL
• Authentication user for BDNA API
• Authentication key for BDNA API

6. Activate SMTP proxy if necessary (provided by your IT service):
• Check Activate SMTP Proxy.
• Enter the address of the proxy.
• Enter the port.

7. Check the Authentication for the proxy option if required.
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Scope of BDNA Connector

Within the context of the technology management in ITPM, the BDNA Connector
enables import of the following concepts:

• Technology types: categorizes software products by the function they 
perform.

• vendors. Example: Microsoft
• Software technologies. Example: MS Office

Mappings with HOPEX concepts are detailed below. 

Object correspondence

In BDNA Technopedia™, software technologies are divided into:
• Products (for example: Microsoft Office)
• Editions (for example: Family, Professional)
• Versions (for example: 2013, 2016)
• Releases (major, minor)

Only versions and releases have information on the life cycle (publication date, end
support, end of extended support).

Software Products imported from BDNA Technopedia™ into HOPEX are saved as
Software Technologies. Editions and versions of a software are represented by
variations of the Software Technology in MEGA.

BDNA HOPEX

Manufacturer (vendor) Org Unit

Taxonomy (technology type) _Type 

Software Product Technology

Software Edition Variation of Software Technology

Software Standard Major/Minor Release Variation of Software Technology
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BDNA properties in HOPEX

Most of BDNA properties imported into HOPEX appear in the BDNA tab of the object
properties

Technology properties related to the official technology life cycle are automatically
defined in the Characteristics tab of the technology properties.

• Release date
• End of Support
• End of Extended Support

 These properties can be specified manually if you do not use the 
BDNA Connector

A Support Alert report uses this data to track technology obsolescence. For
example, the solution automatically detects current and future conflicts when an
underlying technology component becomes obsolete while the business application
is still in production.

See "Support Alert Report vérifier", page 96.
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USING THE BDNA CONNECTOR

With the BDNA Connector, you can import new data or update information on
objects already imported into HOPEX.

Importing new data 

The Functional Administrator is in charge of importing data related to software
technologies from BDNA Technopedia. The BDNA Connector of ITPM enables to
define the scope of data to extract from BDNA.

To import data with the BDNA Connector:
1. Connect to ITPM as a Functional Administrator.
2. On the IT Portfolio Management desktop, click the navigation menu, then 

Inventory.
3. In the Inventory navigation pane, you have access to the following 

folders:
• BDNA technology types
• BDNA vendors
• BDNA technologies

Technology types

Importing technology types implies import of all technology types of the BDNA
repository.

To import technology types:
1. In the Inventory navigation pane, click Types of BDNA technology.

The import tool appears in the edit area.
2. Click Import.

The list of technology types appears. 
3. Click the technology type to see its properties. 

Vendors

To import a vendor: 
1. In the Inventory navigation pane, click BDNA vendors.
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2. In the edit area, click the Import button. 
You can search a vendor by specifying:
• The Industry within which a vendor belongs, based on the majority of 

their products.
• The vendor name.
• The Owner of the vendor. For example, Microsoft is now the owner of 

Skype.
• The Tier level: categorization of vendors based on priority/

importance. For example level 1: well-known vendors.

3. Click Next.
The result window appears. It displays names of the vendors
corresponding to the search. 

4. Select the vendors you want to import into HOPEX and click Import.
The name of the vendor(s) you selected appear.

Technologies

You can import software technologies by name or by selecting technology types and
vendors.

Updating Existing Data

At any time you can update information available on software technologies and
vendors imported into HOPEX.

To do so:
1. In the Inventory navigation pane, click BDNA Vendors or BDNA 

Technologies or Software Technologies, depending on the objects you 
want to update.
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2. In the edit area, click the Update button.

 If necessary, click  to display the hidden commands.

You can also define an automatic update. See "Automatic Update", page 96.
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AUTOMATIC UPDATING AND ALERT 

Automatic Update

Automatic update checks, at a given frequency, if properties of software
technologies imported into HOPEX have changed in BDNA repository and updates
the corresponding technologies in HOPEX. 

Defining Update Frequency

To define automatic update on technologies:
1. Click the navigation menu, then Adminstration.
2. Click Tools.
3. Under Scheduler, click BDNA Automatic Update Configuration.

You can set the alert:
• Daily
• Weekly
• Monthly

Subscribing to Alerts

A user can be notified of updates made on the technologies he is in charge of.

To subscribe to an alert:
1. Right-click the technology concerned and select Properties.
2. In the technology properties, select the Wall page.
3. Under the Subscribers section, check I subscribe.

 For more details on alerts, see the HOPEX Common Features guide, 
chapter "Communicating in HOPEX", section "Threads of Posts and 
Alerts on Objects". 

Support Alert Report vérifier

A Support Alert MetaAtribute available on each technology compares the
technology life cycle (imported from BDNA Technopedia or defined manually) with
its life cycle in the organization. 

 For more information on Gantt and object life, see "Viewing 
Application Life (Gantt Chart)", page 38.
 For more information on the technology official life cycle, see 
"BDNA properties in HOPEX", page 92. 
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It can have the following values:
• Early life cycle: the technology has a life cycle in the organization which 

started before the official release date of the software technology.
• Supported usage: the life cycle of the technology begins after the 

release date of the technology and ends before the end of the support 
date.

• Late usage:  the life cycle of the technology begins after the release 
date of the technology and ends before the end of the extended support 
date

• Unsupported usage:  the life cycle of the technology begins after the 
release date of the technology and ends after the end of the extended 
support date.

A report uses the Support Alert MetaAttribute to analyse technologies in the
HOPEX repository and displays all possible conflicts between the usage of these
technologies in the organization and their official life cycles.

To generate a Support Alert report:
1. On the IT Portfolio Management desktop, click the navigation menu, then 

Reports.
 This report is also available in the properties of a portfolio.

The list of reports appears in the Reports navigation pane.
2. In the Technology folder, click Software Technology Support Alert.

The report appears in the edit area.
3. Select the technologies you want to analyze:

• Technologies of a Portfolio. You can select an Application or a 
Technology portfolio. In case of an application portfolio, it analyses the 
technologies linked to the applications.

• Technologies of a certain Type (Taxonomy).
• All Technologies
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4. Click the Refresh the report button.
The report results appear in the edit area.
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APPENDIX -  HOPEX IT PORTFOLIO 
MANAGEMENT WORKFLOWS

This chapter presents HOPEX IT Portfolio Management workflow diagrams.

 "Application Portfolio Management Workflow", page 12
 "Financial Update Workflow", page 13
 "IT and Business Update Workflow", page 14
 "Technology Validation Workflow", page 15
 "Technology Financial Update Workflow", page 16

 For more information, see the HOPEX Assessment guide.
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APPLICATION PORTFOLIO MANAGEMENT WORKFLOW
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Appendix - HOPEX IT Portfolio Management Workflows
Financial Update Workflow

FINANCIAL UPDATE WORKFLOW
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IT AND BUSINESS UPDATE WORKFLOW
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Appendix - HOPEX IT Portfolio Management Workflows
Technology Validation Workflow

TECHNOLOGY VALIDATION WORKFLOW
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TECHNOLOGY FINANCIAL UPDATE WORKFLOW
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